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· Information Systems (IS) is an integrated, man/machine system for providing information to support the operations, management, and decision-making functions in an organization
· The system utilizes computer hardware and software, manual procedures, management and decision models, and a database
I = i (D, S, t)
· Where
· I = information, i = interpretation process, 
D = data, S = setting/frame of reference, and 
t = time available for the interpretation
· S in the equation is the result of the life experience of the individual. 
· Hence, not every individual will receive the intended information even from simple data. 
· The infological equation has far-reaching implications for the development of information systems and issues of knowledge, information, language, and human interpretation
· The design, development, and management of information technologies, as well as their use by and impact on individuals, groups, and organizations. Of particular interest are information technologies (and their specific components) that enable communication, collaboration, and decision-making.
· Knowledge workers work with and produce information as a product
· Information Systems activities focus on the effective and successful integration and use of information technology systems in organizations
· Requires a broad understanding of information technology and the management, strategy, structure, processes, and information requirements of organizations
Puzzles
· Set of circumstances in which there is no ambiguity whatsoever once some thought has been given to what is happening or needs to be done
Messes
· A set of circumstances in which there is extreme ambiguity and in which there may well be disagreement
· There is a whole range of possible definitions and descriptions of what is going on, and there may be no way of knowing whether a solution exists at all
· Problem Space: initial current state, the goal state and possible states in between
· Problem solving as an everyday activity
· People make decisions every day to solve problems that affect their lives
· Problems may be:
· Unimportant:
· what to watch on TV
· Important: 
· choosing a new profession
· Analysis: Using data to make decisions depends on an organization’s ability to collect, organize, and otherwise transform data into information that can be used to support those decisions 
· Steps in Problem Solving
· Identify the problem
· Understand the problem
· Identify alternative ways to solve the problem
· Select the best way to solve the problem from the list of alternative solutions
· List instructions needed to solve the problem using the selected solution
· Evaluate the solution
· Problems do not always have straightforward solutions
· Some problems can be solved with a series of actions [Algorithmic Solutions]
· Balancing a cheque book or baking a cake
· Others require reasoning built on knowledge and experience, and trial and error [Heuristic Solutions]
· Buying the best stock or expanding a business
· Most problems require a combination of the two kinds of solutions
· Ideal for complex and time-consuming algorithmic solutions
· Computer Program
· The set of instructions to produce the correct result
· Coded in a particular computer language
· Team
· A group whose members are selected based on a variety of criteria to perform a common task
· Teams have many of the advantages (and disadvantages) of any group
· Are difficult to start and must be managed in order to start quickly
· Need individuals in order to succeed
· May not work well with the existing organization
· Need clear direction
· Need leaders
· 4 stages of teamwork
1. Forming
a. This is basically a ‘meet and greet’ session
b. Team should clarify their goals
c. Set rules to for how the team will function
2. Storming
a. Conflict ensues over the direction of the team and over leadership
b. Organization starts to emerge
c. Some ‘turf’ and power struggles may arise
3. Norming
a. Cohesion and communication
b. Agreement on the team’s direction and leadership
4. Performing
a. Finally the team begins to work on the assigned task
b. Members know their role and specific contribution
· A virtual team possesses all the qualities of a collocated team (task interdependence, common goals), but is geographically and temporally distributed and uses communication technology as the primary vehicle of coordination
· Geographically Distributed
· Working in different places
· Cultural and normative differences between team members
· Temporally Distributed
· Working in different time zones
· Technology Mediated Communication
· Many technologies exist (as discussed in this class) but text-based communication remains dominant (i.e. email, chat, etc)
· Differences in working face to face versus virtually can be informed by studying the characteristics of the media channel
· Synchronicity: the ability of communicators to time their message and feedback delivery 
· Presence: the state of being immediately available 
· Reach: the extent to which a media channel allows communicators to send messages to large numbers of recipients who may be physically and temporally distributed. 
· Symbol variety: the number of channels and cues available in a given media through which a message may be communicated 
· Rehearsability: the extent to which message sender can carefully formulate a message before delivering it  
· Reprocessability: the extent to which a medium enables communicators to revisit messages sent and received in the past

· Web 2.0 is a radical democratization of the internet brought about by the development of software that lets ordinary users to participate and express themselves on the Web.
· Ordinary people can upload their photos, videos, stories, etc. and have the community judge them in the spirit of meritocracy.
· The user as centre of the virtual universe
· Simple design
· Ease of use
· Low learning curves
· All users can participate, organize, read, write and play online

· User generated content is value-add
· The more people contribute the better the network effect and the use of collective intelligence
· Traditionally software is released as a packaged product
· Patches and Upgrades always follow
· Some better at doing it than others
· Software can be delivered as a Service
· Patches and upgrades will be out of the users’ concerns
· New features can be pilot-tested immediately before adding them
· Software will be a perpetual beta
· Never a finished product!
· Constantly evolving

Syndication
· Sharing, not controlling
· RSS (Really Simple Syndication) facilitates the sharing of content

· A Mashup is a web application that combines data from more than one source into a single integrated tool
· Of special interest for marketers
· This is what One-on-One Marketing is all about
· The long tail consists of the less popular interests of users
· Adding them up these non-mainstream interests far outnumber the popular ones!
· (25 – 40)% of Amazon.com sales come from the long tail
· Serve not only popularity but fringe as well

Youtube
· 48 hours of video uploaded per  minute
· > 3 billion videos are viewed per day
· “More video is uploaded to YouTube in one month than the three major U.S. networks created in 60 years”
· Most traffic comes from outside the U.S.
· present in 25 countries across 43 languages.
· 800 million unique users visit each month.
· Reached 1 trillion video views in 2011

Bookmarking
· Movement to organize data in the public sphere
· Social Bookmarking sites focus on managing and sharing information
· Examples include
· Del.icio.us, Furl, Blinklist, Magnolia, StumbleUpon
· You can bookmark almost everything
· Web sites, articles, blogs posts, podcasts, images, etc.

Taxonomy: “classification of [things] into an ordered system that indicates natural relationships”
· Bottom-up classification resulting from social tagging
· Relationships between tags are inferred based on usage patterns
· Tagging is done independently
· Tags are aggregated

Wikinomics 
4 Principles: 
· Openness
· Peering 
· Sharing 
· Acting Globally

· Three forces at work creating a collaboration economy
· 	Technology
· 	Demographics
· 	Global Economy
Coase’s Law
· “A firm will tend to expand until the costs of organizing an extra transaction within the firm become equal to the costs of carrying out the same transaction on the open market.”
· Transaction costs
· Search costs
· Contracting costs
· Coordination costs
· At the Fringes of New and Old
· In the old paradigm, there were clear roles and responsibilities.
· In the new world, the lines between sectors and institutions are blurring
5 principles for the 
Age of Networked Intelligence
1. Collaboration
2. Openness
3. Sharing
4. Integrity
5. Interdependence 

· A blog is a Web site, usually maintained by an individual, with regular entries of commentary, descriptions of events, or other material such as graphics or video. 
· Entries are commonly displayed in reverse-chronological order.

Social Discourse
· Discourse is an institutionalized way of thinking, a social boundary defining what can be said about a specific topic, "the limits of acceptable speech"—or possible truth
· Relations of power in our society affect and shape the way we both communicate with each other and create knowledge
· Marc Angenot defines social discourse as all that is said or written in a given state of society

Trust
· Internet users will reveal more personal information online if they believe they can trust the organisation that requests the information
· Even people who have previously demonstrated a high level of caution regarding online privacy will accept losses to their privacy if they trust the recipient of their personal information
· Individuals are grouped into
· [bookmark: _GoBack]“High trusters” trust until they realized that they cannot trust
· “Low trusters” won’t trust until they have assurance that they can

· A worksheet is a spreadsheet that contains formulas, values, text, and visual aids
· A workbook is a file containing related worksheets
· A cell address or cell reference names a cell
· Formulas are combinations of cell addresses, math operators, values and/or functions

· Order of precedence (operations) controls the sequence in which math operators are computed
· BEDMAS

· Auto Fill enables you to copy the contents of a cell or cell range or to continue a series using the fill handle
· Example:  Month names Jan, Feb, Mar form a series 
· The fill handle is the small black square in the bottom right corner of a cell
· Semi-selection uses the mouse pointer to build a formula containing cell references or ranges
· This technique is also called pointing
· Excel offers three types of cell references for use when a formula is copied
· Absolute	$A$1
· Relative	A1
· Mixed		$A1 or A$1
· $ indicates that the row number or column letter will not be modified during a copy
· A circular reference error occurs if a formula refers to itself
· An Excel function is a predefined formula that performs a calculation
· Syntax is the set of rules that govern correct formation of a function
· An argument is an input, such as a cell or range
· A function begins with the equal sign (=) followed by the function name and arguments in parentheses
· When a function is typed, Formula AutoComplete displays a list of functions matching the partial entry
· A function ScreenTip is a small pop-up description that displays the function arguments
· Use the Insert Function dialog box to search for a function or select one from a list
· The Function Arguments dialog box offers help on each argument
· The SUM function returns the mathematical sum of some number of cells or ranges
· Common statistical functions include:
· AVERAGE		arithmetic mean
· MEDIAN		midpoint value
· COUNT			number of values in range
· COUNTA		number of nonempty cells in range
· COUNTBLANK		number of empty cells in range
· ABS			positive value of a number
· FREQUENCY		how often values appear in range
· INT			rounds value down to nearest whole number
· MODE.SNGL		most frequently occurring value
· PI			returns the value of pi accurate to 15 digits
· PRODUCT		multiplies all values within the argument list
· RANDBETWEEN		generates a random number between two values

· The TODAY function displays the current date
· The NOW function displays the current date and time 
· The ROUND function changes the stored data into its rounded form
· When you change the decimal in the number group, you only change what is displayed, not the real value of the number
· The IF function has three arguments:
· A logical test or condition that is true or false
· The resulting value if the condition is true
· The resulting value if the condition is false
· A nested function occurs when one function is embedded as an argument to another function
· Lookup functions are used to look up values in a table to perform calculations or display results
· When searching a range, the breakpoint is the lowest value
· The VLOOKUP function searches a lookup table for a value and returns the result from the related column
· VLOOKUP has three required arguments:
· Lookup value
· Table array (range of lookup table)
· Column index of return value
· PMT has three required arguments:
· Interest rate
· Number of periods
· Present value (amount of loan)
· A range name is a word or phrase used to identify a cell or cell range
· Range names use the following rules:
· 1to 255 characters
· Begin with a letter or underscore (_)
· Contain letters, digits, period, underscore
· Valid names include Rate, Tax_Rate, Rate_2012

Freeze rows and columns
· Freezing keeps rows and columns visible during scrolling

Print large datasets
· The Page Layout tab offers options to help print large datasets:
· Page Breaks
· Print Area
· Page Titles
· A page break indicates where data will start on a new printed page
· Print titles indicate some rows or columns that will repeat at the top or side of each printed page

Understand table design
· A field is an individual piece of data
· Field names appear in the top row as column headings
· Field names should be short, but descriptive
· A record is a complete set of data for an entity
· Each record is listed in a row of the table
· Do not insert blank rows in the table

Apply a table style
· A table style controls the fill color of the header row, columns, and records
· The Table Styles Options group on the Design tab contains check boxes to further format the table

Sort data
· Sorting arranges records in a table
· Records can be sorted in ascending or descending order

Use any of the following techniques to sort on a single field:  
1. Click Sort & Filter in the Editing group on the Home tab.
2. Click Sort A to Z, Sort Z to A, or Sort in the Sort & Filter group on the Data tab.
3. Right-click the field to sort, point to Sort from the shortcut menu, and select the type of sort desired.

· Multiple level sorts permits differentiation among records with duplicate data in the first sort

Filter data
· Filtering is the process of displaying only records that meet specific conditions
· Numeric filters can be applied to display a range of values

Use structured references and a total row
· A structured reference is a tag or table field name used in a formula or function
· A total row appears as the last row of a table and offers statistical functions


Create a new rule
· The New Formatting Rule dialog box is used to create a customized rule

Sort and filter using conditional formatting
· It is possible to apply sorting and filtering commands to data using a conditional filter
· Use the Sort by Color option to group highlighted records
· Sort the field in ascending order to arrange data bars
· Use the Filter by Color option to display only highlighted records

Group and ungroup data.
· Group rows or columns of related data into an outline
· Expand or collapse groups depending on your focus

Subtotal data.
· Use Subtotal command to insert subtotal rows at each designated field change in a sorted range of data 
· Subtotals calculated using summary functions
· Grand totals displayed after each group
· Additional levels of subtotals can be inserted

Create a PivotTable.
· A PivotTable allows you to summarize, analyze, and explore large amounts of data
· Data can be dynamically arranged to view it from different angles
· One column must have duplicate values to create categories for organizing and summarizing data 
· Another column must have numeric values

Change the values field.
· Select the function used to calculate summary statistics
· Default is:
· Sum for values
· Count for text fields
· Specify a custom column heading
· Apply number formatting

Modify a PivotTable.
· Add, remove, or rearrange fields to get a different perspective of the data
· Excel does not automatically update PivotTables

Sort, filter, and slice a PivotTable.
· Default is alphabetical by row label text
· Two types of filters:
· A report filter sets the overall conditions for aggregating data
· A group filter filters out data based on a row or column category
· Slicers:
· Are graphical
· Provide buttons that you can click for quick filtering
· Indicate the current filtering state
· Calculated field:
· Is a user-defined field
· Does not exist in the original dataset

Format a PivotTable.
· Basic formatting applied to PivotTables:
· Primary row labels formatted in bold
· Subtotals are bold
· One Variable Table: tool that provides a variety of results based on changing one variable 
· Two Variable Table: tool that provides results based on changing 2 variables, compares 2 variables

· Goal Seek:
· a tool when you know the desired end result, but do not have the value needed to meet the goal
· let’s you work backwards to solve a problem
· Scenario Manager: 
· scenarios take detailed sets of input values and determine possible results
· enables you to define and manage up to 32 scenarios
· scenarios are maintained separately for each worksheet
· For each scenario you specify; a name, the changing cells, and the values for those changing cells

Generate Scenario Summary Reports: a worksheet that compares the scenario results 
· Does not automatically update so if changes are made to scenarios, you will have to generate a new scenario report 
· Appears on a separate worksheet 

Load the solver add in: 
· Solver: most sophisticated what-if analysis tools, a separate program that must be installed or added to excel
· Appears in the Analysis group on the Data tab until you remove it 
· Solver manipulates variables based on constraints to find the optimal solution

Optimize results with solver:
-Solver has 3 parameters-
1. Objective cell – contains a formula based value that you want to optimize that relates directly or indirectly to the changing cells
2. Changing cells – cells who’s values are adjusted until constrains are satisfied 
3. Constraints – specify the restrictions (less than or equal to)
· Binding constraints: rules that solver enforced to reach the target value
· Non binding constraints: do no restrict the target value  
· If Parameters change then we need a new report

Triple Convergence
· New tools
· New methods
· New markets

The I in ICT
· Information is at the heart of the flattening of the world, no surprise then that the top professional jobs all deal with information 
The C in ICT
· While information is essential, the only way to collaborate is to become an effective communicator – harness your language skills!
· Remember what’s the role of language in communication – any language!
· “it must have been comprehension rather than production that drove the evolution of language” [Burling, 2005]
The T in ICT
· Basically we are concentrating in the technology of business


